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Chapter 1st  
Typing Tutor (Punjabi) 

Que:1 Multiple Choice Questions: 

1. ________ font can be used to type in Punjabi. 

a) AnmolLipi   b) Raavi  c) Joy   d) All of the Above 

2. What is the full form of UNICODE? 

a) Union Code    b) Unified Code c) Universal Code  d) None of These 

3. Which of the following UNICODE font can be used for typing in Punjabi? 

a) AnmolLipi   b) Raavi  c) Asees  d) All of these 

4. Which of the following Phonetic font can be used for typing in Punjabi? 

a) AnmolLipi   b) Raavi  c) Asees  d) All of these 

5. To use number pad, _________ should be kept ON 

a) Num lock     b) Caps Lock   c) Scroll lock    d) None of These 

Que:2 Write True or False 

1. For typing, the keyboard is divided in two parts: one for the left hand and one for the right. (True) 

2. Touch typing is a technique by which we can learn typing with all fingers while looking at keyboard. (False) 

3. AnmolLipi font helps us typing in Punjabi. (True) 

4. We use our little finger for the spacebar. (False) 

5. Shift key is used to move down to a new line. (False) 

Que:3 Short Answer Type Questions 
Q:1 What is Touch typing? 
Ans: Touch typing is a technique by which we can learn typing with all fingers, step by step, without 
having to look down at the keyboard. If all the time, we keep on looking for right keys on keyboard, then 
it slows down our typing speed a lot.  
Q:2 What are the different types of fonts used for typing in Punjabi? 
Ans: There are many different types of fonts available for typing in Punjabi. The fonts commonly used for 
Punjabi typing can be divided into two main types: 

 Phonetic Fonts - Example: AnmolLipi font 

 Unicode Fonts - Example: Ravi font 
Q:3 How to type in Punjabi language? 
Ans: Before start typing in Punjabi, we need to choose the appropriate font for typing in Punjabi. There 
are many fonts which are available for typing in Punjabi, for example: AnmolLipi, Raavi (Unicode Font), 
Asees, Joy etc. AnmolLipi font is a Phonetic Font which is one of the easiest fonts to learn typing in 
Punjabi. For typing with Unicode fonts, Raavi font is commonly used for typing in Punjabi. 
 

Q:4 Name any three fonts to type in Punjabi Language? 
Ans: There are many fonts for typing in Punjabi Language. Some of these are given below: 

 AnmolLipi 

 Raavi 

 Asees 

 Joy 
Que:4 Long Answer Type Questions 
Q:1 How can we improve typing speed? 
Ans: Following are some suggestion which helps us to improve typing speed: 

1. Our hand/finger position should always be in home position. We should reach for other keys 
from home position. 

2. We should focus on accuracy not on speed. Speed will come with time and practice.  
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3. Don’t look at the keyboard while typing. 
4. Be steady, even pace and strive for accuracy.  
5. As we tap each key, we should say its letter to ourselves.  

Q2: What are the important things to keep in mind while typing?  OR 
Explain the proper posture while typing? 

A: During typing, the following things should be kept in mind regarding proper posture: 
1. We should sit up straight while typing. 
2. Our focus should be on the monitor or the copy. 
3. The monitor should be at our eye level. 
4. We should sit up straight in front of the keyboard and monitor. 
5. After pressing the keys, our fingers should be returned on the Home row. 
6. Our feet should be flat on the floor. 

 

Key Map – UNICODE Font: Raavi 

 

Key Map - Phonetic Font: AnmolLipi 

 
 

Chapter 2nd  
Internet Fundamentals 

Que:1 Multiple Choice Questions: 
1. International Networks of Computer is known as________________ 

a) ARPANET   b) INTRANET    c) INTERNET   d) ETHERNET 
2. WWW stands for_______________________. 

a) World Wide Web  b) World Web Wide   c) Wide World Web  d) Web World Wide 
3. A _______________ is an online conversation over the Internet. 

a) E-commerce   b) Chatting    c) WWW  d) None of these 
4. ___________ is the fastest way of sending mails. 

a) Telegram   b) Letters    c) ISP      d) E-mail 
5. ___________ is a device that connects a computer with telephone line. 

a) Modem   b) Telephone Wire   c) Mouse   d) Mobile 
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Que:2 Write the Full Forms of the following terms: 
1. WWW  : World Wide Web 
2. E Mail  : Electronic Mail 
3. MODEM  : Modulator Demodulator 
4. ISP  : Internet Service Provider 
5. URL  : Uniform Resource Locator  
6. DSL  : Digital Subscriber Line 

Que:3 Short Answer Type Questions: 
Q:1 What is Internet?  
Ans: Internet stands for International Network of computers. The 
Internet is a “network of networks” that consists of millions of 
computers spread across the world. Internet is one of the best 
technologies gifted to mankind in the present scenario. 
 

Q:2 Give some examples of Internet Service providers. 
Ans: Internet Service Provider (ISP) refers to a company that 
provides Internet services. Following are the common examples 
of ISPs: 

 Airtel 
 Vodafone  
 BSNL etc. 

Q:3 What do you mean by the term E-Commerce? 
Ans: E-Commerce stands for Electronic Commerce. E-Commerce is one of the most important services 
provided by the Internet.  We can purchase almost anything at any time from home using e-commerce 
websites 
Q:4 What is Web Browsing? 
Ans: Moving from page to page or website to website in search of information is known as Web 
Browsing. To browse or search the information, we can take the help of any search engines such as 
Google, Bing etc. 
 

Que: 4 Long Answer Type Questions 
Q:1 What is MODEM? Also explain its types and speed. 
Ans: Modem stands for Modulator-Demodulator. This device is used for connecting with the internet. It 
enables a computer to transmit data over telephone or cable lines. 
Types of Modem: Modem are of two types: 

i. External Modem: It is a separate device which is connected with the computer using cables. Its 
speed is more than the speed of internal modem. 

ii. Internal Modem: It is fitted inside the system unit. It is slower in speed as compared to external 
modem. 

 
 
 
 
 
 

 

Q:2 Explain the facilities provided by the Internet. 
Ans: Following are the common facilities provided by the internet: 

i. Internet provide us the facility to read news from various online new-papers. 
ii. Internet is a major source of art and entertainment 
iii. We can purchase many types of goods from home with the help of internet 
iv. We can send and receive messages to anyone at any time with the help of internet 

Internal Modem 
 External Modem 
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v. We can book railway/air tickets from home with the help of internet 
vi. We can do chatting with the help of internet 
vii. Internet provides us the facility of video conferencing 

Q:3 What is E-mail? Write the advantages of using email. 
Ans: E-mail stands for Electronic mail. It is one of the most important services provided 
by the Internet. We can send or receive messages to/from anyone at any time using 
email. We can send or receive text, pictures or any type of files using emails. 
Advantages of Email: Following are the main advantages of using email: 

 Cost: Cost given for use of internet is the only money given for using email. 

 Speed: E-mail messages can reach at their destination within no time  
 Convenience: We can send e-mail messages at any time according to our convenience. 

Q:4 Write a note on World Wide Web. 
Ans: World Wide Web is also known as Web or W3. It is a collection of huge information. It includes all 
the public websites which are connected with the internet throughout the world. Each website/page is 
given a unique name/address, which is known as URL (Uniform Resource Locator). We can access the 
information stored on the world wide web with the help of Web Browsers, such as Internet Explorer, 
Mozilla Firefox etc.  
Q:5 What are the main services provided by Internet? Explain briefly. 
Ans: In today's technological world, there are plenty of services that are provided by the Internet. 
Following are some of the important services provided by the internet: 

1. Email: We can send or receive messages worldwide using this service. 
2. Chatting: It is an online conversation over the Internet using text messages. 
3. E-Commerce: Doing business electronically with the help of internet is called e-commerce. 
4. Searching: We can search any type of information on the internet.  
5. Surfing: Process of using websites over internet is known as surfing 
6. Video Conferencing: It involves face to face conversation using video cameras connected to 

computers. 
7. File Downloading: We can download different types of files using internet.  

 
Chapter 3rd 

Introduction to Information Technology 

Que:1 Multiple Choice Questions: 
1. _________ means our computer is receiving data from the Internet. 
a) Uploading    b) Downloading   c) Surfing    d) None of these 
2. The opening page of a website is usually called ________. 
a) Home Page    b) Web Page    c) Main Page    d) None of these 
3. _________indicates a state of connectivity. 
a) Offline    b) Online    c) Inline    d) None of these 
4. ______ means to move from place to place (one website to another website) on the Internet to search 
for the topics of interest. 
a) Web Searching   b) Downloading   c) Web Surfing  d) All of these 
5. ___________ is a form of electronic commerce which allows consumers to directly buy goods or 
services from a seller over the Internet using a web browser.  
a) Net Banking  b) E-Mail    c) Online Shopping  d) Mobile 
Que:2 Write True or False: 

1. The result of any board or university can be seen online.    (True) 
2. Offline means we are connected with the Internet.     (False) 
3. A website has only a single web page.      (False) 
4. Web search is the act of looking for webpages.     (True) 
5. Each website has its own unique website address.     (True) 
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Que:3 Fill in the Blanks: 
I. A collection of one or more pages grouped under the same domain is called _________. 

II. ____________means not connected with Internet 
III. ____________ technology is providing us new tools of communication to collect knowledge and 

information. 
IV. Banks that provide the facility of Net Banking are also known as _____________ 
V. We can buy goods from home using ______________ 

Ans: I. Website II. Online II. Information IV. Virtual Banks V. Online Shopping 
Que:4 Short Answer Type Questions: 
Q:1 What is Information Technology? 
Ans: Information Technology is also known as IT.  It is a technology that is related with Computer Hardware and 
Software. It is used to process, store and transfer information. Information Technology plays a big and important 
role in the progress of any country. It is changing the way of our life style, learning, playing and working. 
Q:2 What is Website? 
Ans: A website is a collection of one or more web pages grouped under the same domain. Pages of website are 
linked together with the help of hyperlinks. Each web page has a unique address which is known as Uniform 
Resource Locater (URL). The very first page of a website is called its Home Page. To view the contents of web 
sites/pages, we have to use web browsers. 
Q:3 What is searching? 
Ans: Searching means finding something. Searching on internet is performed when we do not know the URL of 
web pages that have information to be searched. Search Engines are used to search the information on the world 
wide web. GOOGLE and BING are the most popular search engines.   
Q:4 What do you mean by online and offline? 
Ans: Online and Offline are the technical terms used in the world of internet. Following description 
explain these terms: 

Online Offline 

1. Online means we are connected with internet  
2. When we are online, we are working with the 
files that are stored on the webserver.  

1. Offline means we are not connected with the 
internet.  
2. When we are offline, we are working with the files 
that are stored on our own device (Computer/Mobile).  

Que: 4 Long Answer Type Questions 
Q:1 Explain the Need of Information Technology? 
Ans: Following uses in different areas shows the need of Information Technology:  

1. IT in Business and Industry: Information Technology is required in Business and Industry to make the 
processing of work easier.  

2. IT in Homes: Information Technology is required in homes for the purpose of education, communication and 
entertainment.  

3. IT in Training: Information Technology is required for the training purpose in the field of schools, colleges 
and in many other areas. 

Q:2 Write the steps to view on line result. 
Ans: Following process can be followed to view the online result:  

1. First of all, open any web browser.  
2. Now, type the URL of website having result.  
3. Select the session and class details for which we want to view the result.  
4. Fill the details that are required to view the result-such as roll no, name of student etc.  
5. Now Click on the Search Result Link/Button 

Q:3 Write a note on Mobile Technology 
Ans: Mobile technology is a portable technology. This technology is a part of Information Technology. Mobile 
technology makes it possible to communicate with the places of the world that are very far from us. It has 
completely changed the face of communication. Following are some important uses of mobile technology: 

1. Education 
2. Surveys and Polling 

3. Banking 
4. Data Analysis 
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Q:4 Explain about on-line shopping? 
Ans: Online shopping is a form of doing Electronic Commerce. It allows us to purchase goods and services from 
home using the internet. We can do online shopping at any time from any corner of the world. The bill payments 
of online shopping can be paid with the help of Credit/Debit Cards or Net Banking etc. The purchased items will be 
delivered to our home by the merchant. AMAZON, FLIPKART etc. are the popular e-commerce sites for online 
shopping 

Q:5 What is Net Banking? Explain? 
Ans: Net Banking is also known as Online Banking. Net banking has completely changed the way of working of 
banks. We can do many banking activities from home with the help of internet. Following are some of the 
common activities that we can do from home using Net Banking: 

 We can get details of our bank accounts 

 We can do bill payments of Electricity etc.  

 We can transfer funds to other accounts from our own accounts 
Banks that provide the facility of net-banking are also known as Virtual Banks, Cyber Banks or Web Bank. 

Chapter 4th 
Introduction to PowerPoint 

Que:1 Multiple Choice Questions: 
1. _____________ is a presentation graphics software 
a) PowerPoint  b) Word   c) Excel    d) Paint 
2. A ____________ is the process of presenting a topic to an audience 
a) Word Processor b) Slide   c) Presentation   d) Transition 
3. A ___________ is a single page of presentation. 
a) Slide   b) Document   c) Sheet   d) None of these 
4. ___________ contains the current slide in our presentation. 
a) Outline Pane  b) Content Pane    c) Ribbon      d) Slide Pane 
Que:2 Very Short Answer Type Questions 
Q:1 How to Open PowerPoint? 
Ans: Start  All Programs  Microsoft Office  Microsoft PowerPoint 

Q:2 Shortcut Key to Save the Presentation in PowerPoint? 
Ans: Ctrl+S 

Q:3 Shortcut Key to Close PowerPoint? 
Ans: Alt+F4 

Q:4 Shortcut Key to Start Slide Show from the first Slide?  

Ans: F5 Function Key 

Q:5 What is the file extension of presentation file in PowerPoint? 
Ans: .pptx 

Q:6 Which term/word is used to Open PowerPoint using RUN box? 
Ans: POWERPNT 

Que: 3 Short Answer Type Questions 
Q:1 What is PowerPoint? 
Ans: PowerPoint is a presentation graphics 
software. It is a part of MS Office. It allows us 
to create effective electronic slideshows. We 
can add animation effects etc. to the 
presentation in PowerPoint to make it more 
effective. 
Q:2 Write a short note on Presentation. 
Ans: Presentation is the process of presenting 
a topic to the viewers in an interesting way. 
The purpose of the presentation is to make the 
content easily understandable using pictures, 
text, animation etc. A presentation can have 
one or more slides. We can easily create 
presentation in the PowerPoint. 



8th Class Computer Science (Session 2024-25) 
 

 

Prepared By: Vikas Kansal (CF, S.U.S. Govt. Sen. Sec. School (Girls), Sunam Udham Singh Wala (Sangrur))         Page-7 

(Please Visit http://cspunjab.nirmancampus.co.in for more computer science contents) 

Q:3 What is a Slide? 
Ans: A slide is a page of presentation. It is like a 35 mm film-based slide. The slide can be considered as a 
workspace in PowerPoint where we place the content to create the presentation. A presentation can have one or 
more slides. 
Q:4 Write the main Components of PowerPoint Window. 

Ans: Following are the main components of a PowerPoint window: 

 Title bar 

 Ribbons and tabs 

 Outline / Slides tab 

 Slide pen 

 Notes pen 

 Status bar 

 View options 

Q:5 How will you play presentation for the audience in PowerPoint? 
Ans: PowerPoint provides a variety of ways to play our presentation for viewers. Here are some key ways: 

 Press the shortcut key F5 to start the presentation from the first slide 

 Press the shortcut keys Shift + F5 to start the presentation from the current slide. 
Q:6 Write about Slide Pane and Notes Pane in PowerPoint? 
Ans: Following is the description of Slide Pane and Notes Pane: 

 Slide Pane: This pane shows the current slide in our presentation. 

 Notes Pane: This pane is located at the bottom of the slide pane. This pane is used to type notes related to 
slide contents. 

Que: 4 Long Answer Type Questions 
Q:1 Explain any three components of PowerPoint Window? 
Ans: PowerPoint window has several components. Three main Components are described below: 

 Slide Pane: This pane shows the current slide in our presentation. 

 Notes Pane: This pane is located at the bottom of the slide pane. This pane is used to type notes related to 
slide contents. 

 Title Bar: This is the top bar of the PowerPoint window. This bar displays the name of the software 
(Microsoft PowerPoint) and the name of the currently opened file. 

Q:2 How will you create Photo Album presentation in PowerPoint? 
Ans: We can create Photo-Album Presentations in PowerPoint very easily. The steps for creating a Photo-Album 
Presentation are as follows:  

1. Click on the Insert tab. 
2. Click on the Photo Album option in the Images group and then click on the New Photo Album… option. 
3. The Photo Album dialog box will open. Select the images using the File/Disk... option. 
4. Set up various options for Images in the Album dialog box. 
5. Finally, click on the Create button in the Album dialog box. 
6. This will create a new photo album presentation. 

 
 
 
 
 
 
 
 

 

Chapter 5th  
Advanced PowerPoint (Part-1) 

Que:1 Multiple Choice Questions: 
1. A _______ defines the design and placement of different elements on a slide. 
a) Background Style  b) place holder  c) Slide Layout    d) Pattern 
2. A  ____________ is a blend of two or more colours merging into each other 
a) Theme    b) Pattern  c) Background Style  d) Gradient 
3. ___________ is the default view where we create, edit and design our slides. 
a) Normal view   b) Slide Show   c) Slide Sorter View  d) Reading View 
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4. There are _____ default slide-background styles available in PowerPoint 2010. 
a) 48     b) 4   c) 12       d) 3 
5. The ________ control allows us to zoom-in for a closer look at slide contents. 
a) Zoom   b) Slide   c) Normal View   d) Gradient 
Que:2 Very Short Answer Type Questions 
Q:1 What is the Shortcut Key to Insert a New Slide? 

Ans: Ctrl + M 
Q:2 What is the shortcut key to Create a New Presentation? 

Ans: Ctrl+ N 
Q:3 Which tab is used to format text on the slide? 
Ans: Home tab 
Q:4 Which PowerPoint view is used to deliver our presentation to an audience?  
Ans: Slide Show view 
Q:5 Which bar contains the View buttons and Zoom Slider in PowerPoint? 
Ans: Status Bar 
Que: 3 Short Answer Type Questions 
Q:1 Write the steps to create a new presentation using File tab in PowerPoint. 
Ans: Following are the steps to create a new presentation file using the File tab: 

 1. Click on the File tab. 
2. Click on the New option. 
3. Click on Blank Presentation. 
4. Click on the Create button. 

Q:2 What are Placeholders? 
Ans: The placeholder are the dotted-line containers that are shown on the 
slide layout. They can hold a variety of content, such as: Title, Table, Chart, 
Pictures, ClipArt, etc.  
Q:3 What are Themes? 
Ans: A theme is a predefined set of colours, fonts and visual effects. We use themes in our presentation to set a 
consistent and professional look of our slides. 
Q:4 Write the names of different view buttons available at the status bar of PowerPoint window. 
Ans: The status bar has four view buttons with a zoom slider: 

 Normal View 

 Slide Sorter View 

 Reading View 

 Slide Show View 
Q:5 What is Gradient Fill? 
Ans: A gradient is a mixture of two or more colours that merge with 
each other. The Gradient Fill is an option which is used to apply the 
gradient as a slide background. This option appears in the Format 
Background dialog box. 
Q:6 Which options are available in the Fill pane of the Format 
Background dialog box? 
Ans: The Fill Pen has the following options: 

 Solid Fill 

 Gradient Fill 

 Picture or Texture Fill 

 Pattern Fill 
Que: 4 Long Answer Type Questions 
Q:1 Explain briefly about the different methods to change the appearance of slides? 
Ans: We can easily change the appearance of slides using the options available in the Design tab of PowerPoint. 
The main methods to change the appearance of a slide are as follows: 

 Themes: A theme is a predefined set of colours, fonts, and visual effects. We use Themes to set a consistent 
and professional look of our slides. 

Placeholders 
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 Background style: The pictures or design elements that are placed behind the text, charts, etc. on the slides 
are called PowerPoint backgrounds. We can change these backgrounds of slides with the help of the 
Background Styles option. 

 
 
Q:2 What is Slide Layout? How will you change it in 
PowerPoint? 
Ans: Slide layout defines the design and placement of different 
elements on a slide. We can also change the layout of the slide 
after inserting the slide into the presentation. The steps are as 
follows: 

1. Select the slide whose layout we want to change. 
2. Click on the Layout drop-down menu in the Slides group 

of the Home tab. 
3. Click on the layout as per the requirement.  

 

Q:3 Write about the Slide View options in PowerPoint. 
Ans: Following is the description of PowerPoint's slide view 
options: 

 Normal View: This is the default view where we create, edit and design our slides. 

 Slide Sorter View: This view displays presentation slides in thumbnail form. 

 Reading View: This view fills most of the computer screen with a preview of our presentation. 

 Slide Show View: We use Slide Show View to display our presentation to the audience. 
 
 
 
 
 
 
 

 
Chapter 6th  

Advanced PowerPoint (Part-2) 
Que:1 Multiple Choice Questions: 
1. A ____________ is the visual and motion effect that occurs when we move from one slide to the next slide 
during a presentation 
a) Slide transition  b) Animation  c) Animation Scheme  d) Slide Show 
2. PowerPoint provides _________ types of animations 
a) Two    b) Three  c) Four    d) Five 
3. PowerPoint provides predefined collection of animation effects which are also known as ________. 
a) Slide transition  b) Animation  c) Animation Scheme  d) Slide Show 
4. Full Form of PDF is _______________ 
a) Portable Data Format    b) Portable Document Form  
c) Portable Data Form     d) Portable Document Format 
5. We can save our PowerPoint presentation as a PowerPoint Show with ___________ extension. 
a) .ppsx    b) .ppt   c) .pptx    d) .pdf 
Que:2 Fill in the Blanks: 
1. Using _________ tab, we can apply transition effects. 
2. _____________ option allows us to increase or decrease the duration or time of the effect 
3. ____________ option is used to copy animation effect 
4. To save a presentation file in other formats, we have to use __________ option 

Ans: 1. Transitions  2. Duration  3. Animation Painter  4. Save As.. 
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Que:3 Short Answer Type Questions 
Q:1 What is Slide Transition? 
Ans: Slide transitions are visual and motion effects. These effects are visible to us as we move from one slide to 
the next slide during the slide show of the presentation. We use the Transitions tab to apply transition effects to 
the presentation. 

 
Q:2 What is Animation? 
Ans: Animations are visual effects. These effects indicate movement on the objects during the presentation. These 
slide objects can be anything, such as text, pictures, charts, shapes, etc. We can use the Animation tab to apply 
animation effects to the presentation. 

 
Q:3 What are Animation Schemes in PowerPoint? 
Ans: PowerPoint provides a collection of predefined animation effects. This collection of animation effects is called 
Animation Schemes. We can use the Animation tab to implement animation schemes in the presentation. 
Q:4 How will you preview animations in PowerPoint? 
Ans: Following are the steps to preview the animation effects: 

 Click on the Preview button of the Animation tab. 

 Animation effects will begin to play for the current slide. 
Q:5 Write the name of four types of animations available in PowerPoint. 
Ans: PowerPoint provides four types of animations: 

 Entrance 

 Emphasis 

 Exit 

 Motion Paths 
 
Que: 4 Long Answer Type Questions 
Q:1 What is Animation? What are its types in PowerPoint? 
Ans: Animations are visual effects. These effects indicate movement on the 
objects during the presentation. These slide objects can be anything, such as 
text, pictures, charts, shapes, etc. We can use the Animation tab to apply 
animation effects to the presentation. PowerPoint offers four types of 
animations: 

 Entrance 

 Emphasis 

 Exit 

 Motion Paths 
Q:2 How will you save PowerPoint presentation in PDF format? 
Ans: Following are the steps to save the presentation in PDF 
format: 

1. Click on the File tab. 
2. Click on Save As option. 
3. Set the name and location of the file to save it. 
4. Select the PDF (*pdf) format from the Save as type drop-

down list. 
5. Now, click on the Save button to create PDF file. 

 



8th Class Computer Science (Session 2024-25) 
 

 

Prepared By: Vikas Kansal (CF, S.U.S. Govt. Sen. Sec. School (Girls), Sunam Udham Singh Wala (Sangrur))         Page-11 

(Please Visit http://cspunjab.nirmancampus.co.in for more computer science contents) 

Q:3 How will you apply Slide Transition in PowerPoint? 
Ans: Slide transitions are visual and motion effects. These effects are visible to us as we move from one slide to 
the next slide during the slide show of the presentation. Following steps can be used to apply transition effects to 
a presentation: 

1. Click on the Transitions tab. 
2. Select the desired transition effect from the “Transition to This Slide” group. 
3. Set other options such as: sound, duration etc. 
4. Click on “Apply To All” option to apply the same transition to all the slides. 

 

 
 

Chapter 7th  
Generations of Computer 

Que:1 Multiple Choice Questions: 
1. Second generation used the __________ as their basic component. 
a) Vacuum Tubes  b) VLSI   c) ULSI    d) Transistor 
2. The ____________ generation of computers used VLSI circuits. 
a) First    b) Second  c) Third    d) Fourth 
3. The third generation of computer used ___________ in place of transistors. 
a) Integrated Circuits  b) Vacuum Tubes c) ULSI    d) VLSI 
4. ____________ is an upcoming branch in computer science which interprets means and methods of making 
computers think like human beings. 
a) Robotics   b) ULSI   c) Artificial Intelligence  d) Integrated Circuits  
5. ULSI technology is used in _____________ generation of computers. 
a) Second   b) Third   c) Fourth   d) Fifth 
Que:2 Write the Full forms: 

1. ENIAC  : Electronic Numerical Integrator and Computer 
2. IBM  : International Business Machines 
3. IC   : Integrated Circuits 
4. VLSI  : Very Large-Scale Integration 
5. ULSI  : Ultra Large-Scale Integration 
6. AI   : Artificial Intelligence 

Que:3 Short Answer Type Questions 
Q:1 Write the main features of First-Generation computers. 
Ans: The main features of first-generation computers are: 

 Vacuum tubes were used as basic processing components. 

 Machine and Assembly languages were used in these generations. 

 Size of these computers is very large. 

 These computers produced a lot of heat. 

 These computers were very expensive and difficult to use.  
Q:2 Which technology was used for Second Generation of Computers? 
Ans: Following technologies were used in this generation of computers: 

 Transistors were used as basic processing components. 

 The magnetic core was used as the primary memory. 

 Magnetic tapes and disks were used as secondary storage devices.  
Q:3 What is IC? 
Ans: IC stands for Integrated Circuits. A single IC contains several transistors, registers, and 
capacitors. IC was invented by Jack Kilby. These circuits were used to make third generation 
computers.  

Vacuum Tubes 

Transistors 

IC-Integrated Circuit 
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Q:4 Write about Fourth Generation of computers.  
Ans: The time interval of fourth-generation computers was from 1975 to 1989. Computers 
of this generation used VLSI circuits. These circuits made it possible to build fourth-
generation’s Microcomputers. Computers of this generation were very powerful, small, 
and reliable.  
Q:5 What is AI? Write the areas which are included in AI. 
Ans: AI stands for Artificial Intelligence. It is a new branch of computer science that enables computers to think 
and act like humans. AI includes some of the key areas: 

 Robotics 

 Game Playing 

 Expert System 

 Systems for understanding Natural Languages 
Q:6 Write the examples of First Generation of Computers. 
Ans: Some of the main Computers of First Generations are as follows: 

 ENIAC 

 EDVAC 

 EDSAC 

 UNIVAC I 

 IBM 701 

Que: 4 Long Answer Type Questions 
Q:1 What do you mean by Generation of Computers? How are they classified? 
Ans: In the technical terminology of computers, a Generation means the change in computer technology. Till 
know, Computer Generations have been classified into total five generations which are as follows: 

 First Generation Computers (1942-1955) 

 Second Generation Computers (1955-1964) 

 Third Generation Computers (1964-1975) 

 Fourth Generation Computers (1975-1989) 

 Fifth Generation computers (1989 - present) 
Q:2 Explain Fifth Generation of Computers. 
Ans: The time period of fifth generation computers is from 1989- till date. Fifth 
Generation computers use ULSI (Ultra Large-Scale Integration) technology. These 
ULSI Microprocessor chips contain tens of millions of electronic components. 
Computers of this generation works on the basis of Parallel Processing hardware and 
Artificial Intelligence (AI) software. All high-level languages like: C, C ++, Java, .Net, 
etc. are used in the computers of this generation.  
 

Chapter 8th  
Memory Units 

Que:1 Multiple Choice Questions: 
1. A group of ________ bits is called byte 
a) 8  b) 16  c) 32  d) 64 
2. A bit or a binary digit may be represented by logical ______ and _______ 
a) 0, 1 b) 0, 0  c) 1, 2  d) 1, 1 
3. RAM stands for __________ 
a) Read Access Memory  b) Random Access Memory c) All of these  d) None of these 
4. ROM stands for __________ 
a) Read Only Memory  b) Random Only Memory  c) Read Open Memory  d) None of these 
5. Each track of a disk is subdivided into small portions known as _________ 
a) Sectors    b) Area    c) Cell    d) Tape 
Que:2 Write Full forms of the following terms: 
1. MB  : Megabyte 
2. GB   : Gigabyte 
3. SRAM  :  Static Random-Access Memory 
4. PROM  : Programmable Read Only Memory 
5. IR   : Instruction Register 

VLSI Chip 

ULSI Chip 
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Que: 3 Short Answer Type Questions 
Q:1 What is Memory? 
Ans: The memory of a computer is like the human brain. This is the storage area of the computer in which data 
and instructions are stored. Computer memory is divided into many smaller parts, called cells. Each cell has a 
unique memory address. 
Q:2 Write the names of different types of Memory. 

Ans: Memory can be classified into two main types: 

 Internal Memory 

 External Memory 
Q:3 What is Primary Memory? 
Ans: Primary memory is internal memory. This memory is also called main memory. The CPU has direct access to 
this memory. Computer cannot start without this memory. Primary memory can be classified into two main 
categories: RAM and ROM. The CPU can read data from these memories very quickly. 
Q:4 Write the name of various types of ROM. 
Ans: ROM stands for Read Only Memory. Following are the names of the different types of ROM: 

• MROM (Masked ROM) 

 PROM (Programmable ROM) 
• EPROM (Erasable and Programmable ROM) 
• EEPROM (Electrically Erasable and Programmable ROM)  

Que: 4 Long Answer Type Questions 
Q:1 Explain RAM and ROM. 
Ans: RAM and ROM are the types of primary memories. They are described as follows: 

• RAM: RAM stands for Random Access Memory. It is a volatile memory. It means 
data in this memory gets lost when the computer turned off. It stores the 
programs and data that the computer system is using during our work. We can 
read and write data in this memory. 

• ROM: ROM stands for Read Only Memory. It is a non-volatile memory. It means 
data stored in this memory does not lost when the computer turned off. It stores 
the instructions used to start the computer. The data in this memory can only be 
read, but cannot be written into it.  

Q:2 Explain the External Memory. 
Ans: External memory is also called Secondary or Auxiliary or Permanent 
memory. This memory is slower than the main memory. This memory is 
used to store data and information permanently. The CPU cannot access 
this memory directly. The data stored in the secondary memory is first 
transferred to the main memory, then the CPU can access it. Hard Disk, CD-
ROM, DVD etc. are the examples of this memory.  
Q:3 Explain the Characteristic of Secondary Memory. 
Ans: Characteristics of secondary memory are as follows: 
• It can be a magnetic or optical type of memory. 
• Data is permanently stored in this memory even when power is off 
• These memories keep data safe. 
• The data storage capacity of this memory is quite high. 
• Storing data in this memory is much cheaper than in primary memory. 
• The computer can start without secondary memory. 
• Its speed is slower than primary memory. 

Q:4 What are Tracks and Sectors? 
Ans: Tracks and sectors are the components of the physical structure of a magnetic 
disk. The surface of any disk is divided into a number of invisible concentric circles. 
These circles are called tracks. These tracks are numbered consecutively starting from 
zero. The number of tracks may vary depending on the type and capacity of disks. 
The tracks in the disk are divided into smaller sections, called sectors. Each track can 
have 8 or more sectors. Each sector has a storage capacity of 512 bytes.  
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Q:5 What is Cache Memory? What are its advantages and disadvantages? 
Ans: Cache memory is a very fast semi-conductor memory. This memory speeds up the CPU's performance. It acts 
as a buffer between CPU and Main Memory. It stores data and instructions that are frequently used by CPU. 
Benefits of Cache Memory: 

• Cache memory is faster than main memory. 
• The access time of cache memory is less than that of main memory. 
• It stores programs that can be run in a short interval of time. 

Disadvantages of cache memory: 
• Storage capacity of cache memory is very small. 
• It is very expensive. 

 
 


